NetBeans
Platform

What is it?
How do | use it?
And why should | want to?




Agenda

* Introduction
* 1. Why?

» 2. What?

* 3. How?

* 4, When?

» Conclusion
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[ Open Source Java Directory

The Open Source Java Directory iz maintained by Steve Mallett, creator of
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- Search 5 ¢ Favorites € \t

L':”;Ii_r' QSDir o,
Feqister
Man
ter Tour Books We welcorne and encourage readers to add new What's New:

product titles to the directary, All submissions go
through an editorial review before being posted to GEz-Java
Sponsored Developer RGEREEE

JTrac
Resources D
Daoc-zero: implermend

your DAC intefaces

oper Zone

0 Training

You'll need to be ragistered with the CO'Reilly Netwark
to create or update entries,

DualRpc easy
bidirectional RP< for
® Mot yet registered? You can do zo here, cliant ta zeruar

® MNeedto update a product entry vou
previously created? Login to do so here,

® HNeed help? Ernail help@areillvnet. corn

What are those funny

green links Browse our directory:
ONlawva Topics ABCDEFGHIJKELMMOPOQRSTUN WK Z
Update
ActiveMd ActivelM( is a fast open The Apache HMow 26,
source M= 1, Software 200s
License
Activity Manager Activity Manager is a BZD License Apr 4, ZI

project managerent tool (BSD)
that is simple to use,
lightweight, and wery

efficient and customizable,
-

|
|_|_|_|_|_|ﬂ Internet 4




@ Sun

microsystems

a http:/ /www.onjava.com/pub/q/ja¥a_os_directory - Microsoft Ink ;|g|5|
File Edit “iew Favorites Tools  Help #
G Back = \_) . Iﬂ IE"I ;,] /-__ ) search M:-:\-,a- Favorites @? o ; = . »
Address :E'j hikkps ffwivaw, onjava,com)pubfgfiava_os_direckory#1 j a G0
Y_l' - évl jSearchWeb - & B B @l Camail ~ B~ B

IBM Jikes Jikes is a compiler that IBM Public  Sep 18, ;I
translates Java source files License 2002

as defined in The Java
Language Specification into
the bytecoded instruction
set and binary format
defined in The Java Wirtual
Machine Specification,

InfoSapient InfoSapient is an Open IBM Public  Oct 3, 20
Source, Common License License
0.5, Java 1.2 and above,
program for the easy
expression, execution and
maintenence of business

rules within a company. _
iS00 ISOL(IndependentsQL- Mazilla Qct 8, 20
Yiewer is a JDBC 2.0- Public

cormnpliant application that is License
designed to explait JIDBC (MPL)
Features for all compliant

drivers.
iText iText is a library that allows GHU Lesser Feb 14,
vou to generate POF files General 2002
an the fly. Public
License
(LGPL)
ITracker: Java ITracker is a Java J2EE GHU Jun 5, 20
Issue Tracking issue tracking system General
Software designed to support Public
rultiple projects with License
independent user bases, [GPL)
JacoRE Java implementation of the GNU Lesser Aug 6, 2
OMG's CORBA standard. General

F‘.uI:uIic -
______ _>I_I

|
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a JFugue - Ja¥a API for Music Programming - Microsoft Internet Explorer

File Edit ‘iew Faworites Tools  Help ﬁ.

@Eackvo- @ @ {h|p53arch '}"LL&"Favnrites @|@T"}T|_J.O >
address I@ htkp: e, Fugue, arg)f "I a0

Y_r - cf'l jSearchWeh - & - 8- ®| dMal - iy My Yahoo! = ¥

JFugue ;

Java API for Music Programming

Welcome L atest News

Download Coming Soon: JFugue 3.0 (For now, please enjoy JFugue
Programming 2.1)

JFugue

JFugue

JavaDoc JFugue is a Java API for music programming. It

makes music programming incredible easy, and it's

Interesting great for applications in which music is generated at

Topics . . . . . ;

p. run-time: algorithmic or evolutionary music, music
Projects editors, jazz improvisers, and more! -
a i B

€] LD e et 4
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a JFugue - Ja¥a API for Music Programming - Microsoft Internet Explorer

File Edit Wiew Faworites Tools  Help a'

@Eackvev @ @ {:j|ﬁﬁearl:h "gj:S"Favnrites @' &%T;TI_J. *
Address I@ htkp: f femne . jfugue.org) "I G0

Yf - cﬁvl jSearchWeh|v & 5 - @| Camal - %My Yahoo! = **
. J..I
wishlist of Main Features
Features - Music is easy to program, or to generate, with
C Music Strings
omments . Patterns allow musical segments to be added and
from JFugue recormbined
HEErE » Pattern Transformers permit dyvnamically changing
About the a pattern of music
Author » Music can be playved at runtime, or saved in MIDI
- files
License » Lets vou play with music without having to know
Donate the guts of MIDI
To program music, vou use music strings to specify |

the music you want to play. To play a C note, you
basically say play(rcry ;. You can use JFugue's Music
Strings to specify additional effects - instrument
changes, multiple voices, tempo, and MIDI
controller events. You never have to deal with low-
level MIDI messages to use JFugue,

1] I_rrIj
€]

| | | | | |ﬂ Intermet i
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E@ jfugue.jar
M- META-INF
58 og
F- fugue
D dema
D examples
Contraller.class
EventManager.class
@ Instrument. class
@ JFugueDefinitions, class
@ JFugueElement . class
@ JFugueE xception, class
Mote.class
@ Parser.class
@ Farserlistener, class
ParserListeneradapter. class
Patkern.class
@ PatternFactory.class
@ PatternToal class
@ PatternTransformer.class
Player.class
E& Player

Aﬁ’ Fields

ﬁ‘ﬁ Construckars b

=-4% Methads

> ------ @ getSequencer

[£| Renderer.class
@ Temnpo.class
|2 Yoice.class ll
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play():

Pl ayer player = new Pl ayer();
Pattern pattern = new Pattern(string);
pl ayer. pl ay(pattern);

save():

Pl ayer player = new Pl ayer();
Pattern pattern = new Pattern(string);
pl ayer.save(pattern,"Mfile.mdi");

© 2006 Sun Microsystems
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string = C5q Dbq E5q C5q
I[CelTo] E5q F5q Gbh

| [ Trunpet] Gbi A51 Gbi F5i
E5q C5qg | [ Piano] C5q (Aq
C5h . C5q D5q E5q C5q

I[Cel I o] E5q F59 Gbh

|| Trunpet] GbI A51 Gbi FSi
E5g C5q | [ Piano] C5q (Aqg
C5h Cbg D5g E5g Cbqg

I[Cell o] E5q F5gq Gbh

| | Trunpet] Gbi A51 Gbi F5i
E5ﬂ C5qg | [ P ano] Cbg (AgQ
C5
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Music MotePad - | |:||5|

File Tools ‘Window Help

i T 5 [ &
= B =5 & 5
|Palette [ x|
[=] Category
=
[ P -GI
_| T _| 1 '7I\ ﬂ
a2
- I i | I =,
.J Music NotePad =]
File Tools  window  Help
G) ; ) o= B 5 & 2
L]
- == Trumpet x| 4| »| =] | |Instruments Window O X 1 JFugue Com... [ X |
P EEY S ORI M | R
['—jJ Piano . Rg
—— = e ®  Acoustic Granc G52
_ I I — ] ® Bright Acoustic Eéz
- a: i -HEN N I R ®  Electric Grand I[ACOUSTIC GRAl
- i &  Honky-tonk Piz REs
e o ® Electric Piano 1— |F &g
------ ®  FElectric Piano : Big
T T (= ® Harpsichord hag
4] —N I' 1 lF |' ...... o Clavi Gég
— -~ 1l H llh¥~ [+  Chromatic F g
Successfully added Quarter Mote at G5g Y s -] Crgan Rig
| J GLitar I[ACOUSTIC GRM
| J Bass D ﬁq j—
I‘-Fl T Strinns h =
{2 il N | mNjn ES
ves 3
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Demo!
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Join the

team!

https://nbjfuguesupport.dev.java.net/
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E|Mv Rich Client Application - |EI|5|

File Edit Wiew Mavigate Tools ‘window Help

Blo@ @A AP
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SysUpTime: Network Management System
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Nokia NetAct: Mobile Network Manager
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Fiorano Studio: Lego Blocks for SOA

E Fisrano Studio
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Bl test_irwaberwed @ : i |
B tes_pertners.vd query accourts department for ﬂﬁ] E"ﬁﬂllﬂ
ol i = hesance R—. ¥ Flle
 Structure |“BPEL Bird .. 4 = j & o 4
§ o7 Swilkch | i Properties of Company1 "X
b d — CEem v T—— :g'-i'ﬁ L 11@

N = Propertics
i Sequerce | | | Fartraer Uk
v ﬂ" riabfy requestor by phe ot Trps

pfEn P — Cosration
Intimation Inpuk Wariabs

Cotpzacal iy Costprut Varisble
< Dalebs Dalste ]| » Mame Compariy1
F———— 1&-hitlcon
:BPEL Brror Messages Rensme... L] 32-bit Teen D fiorancday_inskaler)...
= B companyl Toggle Breakpoint CirleFy #||  Haote rudl
) “Partmer Link” must be sped Secianics reak Foint L
@ “Port Type” must be sped o Flowe
@ “Operstion” st be speci Business Companant ¥
2 B CompanyZ Process LD ] panyl
i “Parner Link” must be spe Group Wih k| Hescrptian avalable,
Save Al Firished. 1T of 200 | T

© 2006 Sun Microsystems



Sun

microsystems

Streamsim IDE: Oil Flow Modeling
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NetBeans IDE 5.0: Java Development

NetBeans IDE 5.0 - GUIFormExamples
File  Edit

Wi  Mavigate Source Refactor  Build Run CWS  Tools  Window  Help

LEEB Ysa80 L2 BB PDD

‘Projects a4 x || [=] Ankenna.java x] 4 rl=| |:palette I x
= s Swin ”~
= &EEUIFurmEHamples SR | Design | | Ekl% . H : E E |¢>| it = q -
EEEI---I:@ESDUWE Packages — | [ e kel g
H E....@ﬂeximpbs | | =1 JBUtkon
H- [EY™Antenna. java PasitionfCireckion
- @:uf ]_ ] ! (] 1ToggleButton
. @ CDI’ItﬂEtEdItDI’.]E'\"ﬂ I---!:lirPann f°1:| 140,000
- @.u.ﬁnd java i i— - ICheckBox
i ioht [l 110,000
. @ Libraries Height Im i ~ @~ JRadioButkon
EI----&ﬂHEIIDWDrIdP'lug-inMDdule | Height is Lower Edge {Nat Center) = g: ButtonGroup o
Swskem : jTextField? [ITextFi.. I =
< i | > P
Channels: | 2 | watts: | 12,000 [ Properties | Events
: Inspectur a1 = Code
S s Antenna Tvpe: |Kathrein 742151 = ;
EI |:| ]F'anell [IPanel] - e | =IProperties [
~wet jLabelt [ILabel] B Electrical Downtilt From [*]: | 0.000 | To: | 10,000 background [ [255"@ v
5------!«»' jLabelz [JLabel] - - -
: N - jTextField? [ITextField] .
O3 {TextField1 [TTextFisld] Polarization: % +45
F Lv W
: : — Ta.FioldA AT el A7 r 1 r —_—
4 iilf ] ¥ < JilF ] ¥
: Output - suite13 {run) =
Operating System = Windows XP wversion 5.1 running on xE86 LS
Jawa; WH; VWendor; Home = 1.5.0_05; Jawva HotZpot (TM) Client VM 1.5.0_05-b0O5; 2un Microsystems Inc. ; E:‘-,Prngl:
Zy¥stem Locale; Encoding = en US (suitel3); CplZLz b
Home Dir.; Current Dir. = C:hZDocuments and Settingsi\idwinistrateor; C:hZDocuments and Settings\idwministratorh:
Tom—t+ =1 1 m+5 i~ = TT—mn= TS - M v Timmara st = manm]l e Srmmrmt AAlrns e v, e, vt m T 0L TS 1T AL a T, T - L T e e TA 1~
£ | 1l ¥
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|:|My Rich Client Application O] x|

File Edit Wiew Mavigate Tools ‘Window Help

Blor@ @A P
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How: Does NetBeans IDE Help?

Before NetBeans IDE 5.0:
+ No specific user interface support in NetBeans IDE
« Little/no documentation

Since NetBeans IDE 35.0:

+ Wizards

+ Templates

+ Specific enhancements/support for Platform Apps

- A lot of API documentation, tutorials, blogs, samples

©2006 Sun Microsystems




How: What's the Process?

1) Project templates: Basic source structure
2) File templates: Skeleton APl implementations

3) Getting further:

+ Matisse!

+ Highly Advanced Source Editor
+ NetBeans API Javadoc

+ Tutorials

4) Menu items: Build, install, test, and debug...
5) User interface support: Branding & Distribution

©2006 Sun Microsystems



Step 1: Project Templates

Choose Project

Categories: Frojects:

~2 General % Module Project

-5 Web % Module Suite Project

33 Enterprise % Library Wrapper Module Project
3 Mobile

10 MefBeans Plug-in ModLles

* Module Suite Project
> Application structure.

* Module Project
> Wrap functionality.

» Library Wrapper Module Project
> Wrap external JAR files.

© 2006 Sun Microsystems



Step 2: NetBeans APl Templates

e File Type
P1t|aH||W|dp|g-Md| v
Categaties: File Types:
~{C3) Java Classes = 125E Library Descriptar

& Wizard

%[5 Java GUI Forms =d Action
_____ 5 JavaBeans Objec i 1= aHelp Help Set
..... & nk @ File Tvpe

M Module Inskallsr
----- I MetE Module Development & .

Zio. Options Panel
----- i Eﬁ Project Template
----- L) Ant Build Script & Update Center
..... I oth

] windaw Component

 Action wizard

> menu items, pop-up menus, toolbar buttons, keyboard

shortcuts

* Window Component wizard
> GUI custom components (Matisse!)
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Step 2: NetBeans APl Templates (Ct'd)

* File Type wizard
> recognizing new file types

» Wizard wizard
> wizard for generating wizard skeleton...

* Project Template wizard
> bundles samples and templates

» J2SE Library Descriptor wizard
> makes new JARSs available to users in the IDE
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Step 2: NetBeans APl Templates (Ct'd)

» Options Panel wizard
> extend the Options window (give your users options)

- JavaHelp Help Set wizard
> wizard for setting up JavaHelp help set

» Update Center wizard
> support your distribution process

* Module Installer wizard
> before the application begins, initialization functions
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Step 3: Develop the Application

* Get to know the NetBeans APIs
» Use the NetBeans Source Editor
» Read the NetBeans API| Javadoc

Html*
P £ HEmBrowsear (org.openide.awt) ped[java.awt.event.KeyEvent evt) |
/4 md S HimIRenderer (org.openide.awt) ke

Hth:I

@@

org.openide.awt.HtmlBrowser =

—_

public class HtmiBrowser
extends JPanel

-]

{Obiject that provides wviewer for HTML pages.

If all wou want to do is to show some URL in the IDE's normal way, this is

} crverkil, Just Lse HewlBrowser . URLDisplaver. showlRL (ava. net. URL)
instead. Using HtwlBrowser is appropriate mainly if you want to embed a web
browser in some other GUI compaonent (f the user has selected an external
bromeser, this will fall back to a simple Swing renderer), Similarly Tupl (Coming
from a Factory) is the lower-level renderer itself (sans toolbar),

Summary: for client use, try URLDisplayer. showlRL, OF for more confrol or
wihere embedding is needed, create an HewlBrowser., FOr provider use, create M




Step 3: Develop the Application (Ct'd)

» http://platform.netbeans.org/tutorials
> Quick Start Guide

> FAQ
> Tutorials

< netBeans:

platform v

Search

* NetBeans API Javadoc
* Tutorials
» Articles

*» Guidelines

- 8%
Downloads Products Docs & Support Community About Switch

HOME = Community > Projects = platform

MetBeans Module (Plug-in) and Rich Client Application Development

Developers have been successfully writing NetBeans plug-in modules for years, but
MetBeans IDE 5.0 makes the workload much lighter and the process a lot smoother. The
IDE offers comprehensive GUI support for building IDE plug-in modules and rich client
applications on the NetBeans Platform. Many wizards for extending the IDE and creating
applications on top of the NetBeans Platform are provided. Using brand new templates in
the New Project wizard and New File wizard, you can generate all the basic files and code
you need. The Project Properties dialog box lets you configure API dependencies,
manifest entries, and other project metadata. Code completion and other standard
support provided by the IDE's Source Editor is available for plug-in modules too.

This site is home to everything vou need—NetBeans API Javadoc, tutorials, and FAQ.

You've come to the right place if you are a developer who wants to extend the NetBeans
IDE or build rich client applications on top of the NetBeans Platform.
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Step 3: Develop the Application (Ct'd)

* Matisse! Matisse! Matisse!

Edit: Texk
Change Yariable Mame ...

Events

T 7 [

- |

[=] JBuUtkon

[=] JToggleButton
=— JCheckBox
=~ JRadioButkon
&~ ButtonGroup
= JComboBao:
= st

— ITextField

[*] ITextarea

—

| Multiple Objecks - F

Properties Eve

anchor ] Righk ko Column
Auto Resizing ] Top ko Row
Same Size ¥ Boktom ko Row
Set Defaul: Size LefE

Space Atound Component..., Right

Mave L Top

[Aoye D Biokkam

Cuk kel

Copy kT

Delete Delete

Properties

© 2006 Sun Microsystems

[=IProperties

ackion

backaground
componentPopupMe
font

foreground
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Step 4: Build, Deploy, Test, & Debug

» Build Project BT g

EI Source Pa
?ﬂ& Build Project
=& gorg.ne

* Run Project PRy
» Debug Project

» Create NBM File
» Install Project

[ﬂ@ Unit Tesk F Set Main Project
El@ Irportarit Cpen Reguired Projects

¢ etC -8 Libraries Close Project

Find. .. Ckrl+F

Debug Project
Fun Unit Tests alk+Fa

Generate Javadoo

Generate Architecture Description

InstallfReload in Target Platform

Rename Projeck

o etC Move Praject
aEnn

Copy Project

Delete Project Delete
W5 b
Tools ]
Properties
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Step 5: Distribution...

£ Advanced Options
Cpkions

.\ [=IPropetties

Sun

microsystems

@ Options Server LRL hktps i iblags sun. camfraller fresources)geertian/updates_aeertian, xmi
: - Enabled
E-IC3) Editing :
_ _ Time of last check  1/14/06 7:26 P
Ella IDE Configuration Identifving Mame Geertjan's Update Center (]
la Lok and Feel
@ Server and External Tool Setkings
Ella System
&Q Flle Types Awailable Updates and Mew Modules:
LT_I@ Object Types = a Geerkjan's Update Center ad
¥ System Sett =52 Editor Extension Samples
..... YIRS SEHngs @_ Actions BPT Sample (Coakiedction)
E'& Adtoupdate Types @ Loaders API Sample
. - EE!E!rtjElrIIS |_||:II:|EItE! _enter . ______ ﬁ Palette API 56IT||2||E (5||TI|:||E:|
""" & MetBeansUpdate Center | i Palette API Sample (Complex)
------ &9 MetBeans Hotfix Update Cenker | T Text API Sample
------ ﬁ Third-party Update Center | e @ Editor Module Library APT Sample
. MetBeansUpdate CenterBeta | | 3 CodeFoldingSupport 7
...... & Update Center ﬁ Multiview AP Sar.nple
...... @ Suggestions Framework Server URL -5 Miscellaneous Extension Sarmples
URL of Autoupdate Serwer || i e ﬁ_ Actions API Sample (CallableSystemaction)
[#-#a@ Print Settings )
e e [ (] IR B ﬁ Cpkions APT Sample
Ella Tesng L T JavaHelp API Sample
~--df@ JUnit Madule Settings =53 Matisse in &ction Samples
- ﬁ_ Customers In Matisse Sample —
Basic Options Elﬂ Fully-Functioning MetBeans IDE Extensions
@ HelpForJavakeywords 3z
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...but first... branding...

E|Prujecl: Properties - Paint Application 5'

Cateqgaties:

o D SOUFCES Frogress Bar:

...... o Libraries [+ Enabled Color: |.[255,51,|:|] ;I Positioning:  [1,326,494 4

El 2 Application

Running Texk:

I < | ach Screen
Size: |11 Color: II:l‘fellu:uw LI Positioning: |33,31D,3EII],11
Splash Screen:
Browse, .. |

Help
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@ Sun

microsystems

E]Pruject Properties - Feed Reader Application j EI
Cateqaties:
e O GOLPCES Progress Bar:

@ Libraries ¥ Enabled Color: | E [255,114,0] | Positioning: |?5,153,245,5

El 2 Application

Running Texk:
N - |55 Screen

Size: |11 Color: II:l"feIInw ;I Positioning: ITT,148,321,12
Splash Screen:
Browse. .. |

Feed Reader Demo

by Rich Unger

K I Cancel | Help
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Sun

microsystems

ZIP file generation (plus launcher)

ocs 4 x [ ot I -loix

=
T

% FeedReader File Edit ‘iew Fawvorites Tools  Help ﬂ"
B8 SWFeed Reader Applicgtios i
H o
- M jdom ki g @ Back ~ | i - IE p Search H__L' Folders
a Fame Build Al = = =
M. rome-fetcher Clean and Build 4l Address IEJ Cr\Documents and Setkings)Geertian 'u'u'ielerj Go
- & webspplication15 Clean Al Mame = | size | Type | Date Modified |
[+ M WicketSupport Fun [Cbin File Folder 3/17/2006 11:36 PM
[+ M WicketTemplate Debug ete File Folder 3(17/2006 11:36 PM
Build 7IP Diskribution |hfeedreader Ffle Folder 3/17/2006 11:36 PM
: — [hplatforme File Folder 3/17/2006 11:36 PM
Build JNLP Applic ation | DISTRIEUTION ~ 9KE  Text Document  1/25(2006 5:46 PM
Run JMLP Application [Z] LICENSE 39KE  Text Document  1/25/2006 S:46 PM

Debug JMLP Application

s =18

Set Main Project

: ) File Edit Wiew Favorites Tools Help ﬂ'
Open Required Projects

. >
Close Project @Eack o {f i = IE p Search H__L' Folders

Find. .. Ztrl+F

Address C\Documents and SettingsiGesrtian wisler = | 4 Go
Rename Project IE:' II' 2=l ] J .

Mowe Project Mame = I Size | Type
Delete Project Delete Feedreader Z2KB  File |

. . 42 KB  Application
LD G Efeedreader_w 29KE  Application
Y5 F
Tools r
Properties I 4 I | _I*I
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...or a JNLP application!

T x I runtne - JNLP applications can be

- M FeedReader

. » . : delivered and started over the

: o Buid Al Web

Y- M rome-fetcher Clean and Build all '

- (2 webapplication1s Clean Al . . .

D9 vt » With one menu item in the
- M WicketTemplate Debug

Build ZIP Distribution | D E ,. yOl.J Ca n paCkage yo u r
application as a JNLP

Fun JRLP Application

Debug IMLP Application a p pl icati O n y for easy

Creake MEMs

distribution to your end users.

Jpen Required Projects

Zlose Project

Find. .. Ckel+F 4 Java Web Start
Rename Project
Move Project « Feed Reader Application
Delete Project Delete =2 Feed F ler lication |
Profile Project
WS b Validating core_feedreader. jar from
Scanning entries (30% done)
Tools r
Properties e e
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Show me! Demo...

1.Create a rich-client application skeleton (the core).
2.Bundle the JFugue API.

3.Add module for functionality (with Matisse).

- JTextArea
- JButton: Play
- JButon: Save

4.Call “Play” and “Save” methods in the JFugue API.
5.Create a distribution.
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Summary

» Developing on the NetBeans Platform since 5.0
> Wizards and templates
> Matisse for intuitive GUI design
> NetBeans API JavaDoc
> Samples and Tutorials

* Need help?

> dev(@openide.netbeans.org
> http://blogs.sun.com/geertjan
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mailto:dev@openide.netbeans.org

Questions & Answers

Q

@
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jdkhome="C:\Program Files\Java\jdkl.5.0 06"
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